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The Palm Interactive Boardroom (Group 30) uses freepository.com for an automated version control system for the Palm Interactive Boardroom (PIB) project.  The freepository.com CVS repository allows either Web-based or CVS client access to files.

The repository can hold the complete set of project files, the most important of which are the source code, header and UI resource files.  The makefile file and subordinate directory structures can also be maintained.  Files can be checked out but not locked, making it possible to start multiple branches.

By maintaining the makefile in the CVS repository and using the PalmOS Developer Suite IDE, builds will be consistent and standardized among the members of the development team.  The IDE compiles the code each time any source code or header file is saved and displays visual and textual references to any errors.  Only error-free files should be reintroduced into the CVS repository as new versions.

There are two methods to check out the latest code versions from the repository: 1) using the Web-based interface through freepository.com, or 2) using a CVS client such as WinCVS and the supporting applications.  Detailed instructions to configure an account and access files at freepository.com and to configure and use the WinCVS client are outlined below.  Simple file access instructions for the two systems are as follows:

Web-based CVS file access: log into freepository.com using individual account information, access the PIB repository by using the PIB group credentials, open the PIB folder and the major version folder, double-click on the file or files to download the files to the local workstation, and use the file upload interface to update files to the repository.

WinCVS client file access: with a correctly configured WinCVS tool, open the Admin menu, select Login, select the appropriate settings from the drop-down menu, and click OK to login.  Open the Remote menu, select Checkout, enter “pib” for the module name, select the appropriate settings from the drop-down menus and click OK.  The latest versions of the files will be copied to the local workstation directory specified during the client setup process.  Right-click on any of the files in the client window and select either update or commit to update the changes in the repository.

Detailed instructions for the CVS Setup Procedures for PIB are as follows:

· Using a current-generation Web browser, open https://freepository.com
· Set up your personal user account (one time only—thereafter, simply Log In using your credentials)

· Click Register

· Enter a “Member Name” (your choice—will need to be unique on that system)

· Enter a password of your choice

· Enter a valid E-mail address (CVS repository changes notices will be sent to this address)

· Click “go to Your New Account”
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· Join the PIB repository group (one time only)

· Click “Join” at the top of the window

· Enter “pib” for the repository

· Enter password

· Click the Join button

· Click “Go to your freepository now!”
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· Select “pib” from the drop-down menu as the “Current repository” at the top of the window (click “go” if the browser doesn’t switch to the “pib” folder
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· Navigate to PIBv32 to view the files in the repository

· Click on any of the files to get file-specific information or to download a file from within the Web browser

· Click on Secure ID entries toward the top and at the far right to generate secure ID credentials for use with a CVS client.
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· Click on My cvsroot to view your cvsroot string

· The CVS repository owner is initially the only person who can add files to the repository

· Once the CVS repository owner knows that you have created an account, he or she can change individual users’ privileges from “read only” to “basic” (or even “administrator”), allowing Web-based file uploads (create new directories, etc.)
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Detailed CVS Client Setup procedures for PIB using the freepository.com CVS repository (Windows XP computer workstation) are as follows:

· Download and install the WinCVS client, and the CVSNT and Python applications from the UIUC AITS Web Pages -  http://www.aits.uillinois.edu/live/Site.xml? (use the default installation settings)

· Download and install the SSH client - http://charlotte.at.northwestern.edu/bef/SSHdist.html
· Start WinCVS and configure the client as follows:

· On the Admin menu, choose Preferences

· Under the Globals tab, uncheck 'Prune empty directories' if you want to see empty directories (recommended). Leave 'Supply control when adding files' selected

· Under the WinCvs tab

· In the text box next to 'Python DLL:', enter 'C:\WINDOWS\system32\python24.dll' (without quotes)

· In the text box next to 'TCL DLL', enter 'C:\Python24\DLLs\tcl84.dll' (without quotes)

· Click OK

· Exit WinCvs

· Start WinCVS again

· Open the Admin menu and select Login

· Cut and paste the cvsroot string (from the E-mail message sent by freepository.com or from the cvsroot menu within your account at freepository.com)

· Between “:sserver:username”, enter “;version=1” (semicolon version =)

· Click OK to login

· Enter your password

· Exit Code 0 indicates success
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· Checkout files from the repository

· Enter “pib” for the Module Name

· Browse to the appropriate local path to save checked out files

· Select the login string from the drop-down menu (CVSROOT:)

· Click OK to check out the files to your local workstation
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· Right-click on the locally stored files for update or commit features
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The freepository.com CVS repository uses the sserver protocol for file transfers.  The PalmOS Developer Suite IDE can be configured to integrate with the freepository.com CVS repository by installing a plug-in for the IDE.

· Unzip the “rwi.eclipse.team.ccvs.ssl_1.0.6.zip” files to the “eclips\plugins” directory within the IDE directory structure (typically C:\Program Files\PalmSource\Palm OS Developer Suite\eclipse\plugins\.

· Download the Zipped files from http://home.arcor.de/rolf_wilms/cvsssl/cvsssl_help.html
· Start the Palm OS Developer Suite IDE

· Open the Window menu, select Preferences and confirm the settings
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· Open the Window menu, select Other, then select CVS Repository

· Select New CVS Repository and enter the information from your freepository account in the appropriate locations.

[image: image12.png]P il €95 Hagusiisy

Add a new CVS Repository

Add a new CVS Repository to the CVS Repositories view ‘r

~Location

Host: [feepostory.com =
Reposiory path: [/ 1/37GoMICFSPIpb =
Authentication

User =

Password: [rrrers

- Connection

Connection type: [cus-sserver
 Use Default Part

@ Use Port: [B608 &

¥ Validate Connection on Finish
I~ Save Password

/i, Saved passwords are stored on your computer in a file that's difficult, but not
impossible. for an intruder to read.





· Select the “cvs-sserver” Connection Type

· Enter port 8608, then click finish

· You can now synchronize your local files with the files in the CVS repository
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There are several methods available to check out and update files using the freepository.com CVS repository.  Since the repository tracks all changes, the developers can individually choose the most suitable method to use.

CS428(Spring 2006) - Homework 2



Ebengt2 – Eric Bengtson

Palm Interactive Boardroom (PIB)



Hjung20 – Hee Won Jung

Group 30, Sub-group 2





Senalee2 – Sena Lee

February 9, 2006







PIB::Change Control Policy
We are currently examining options to control the changes to software versions and configurations.

Document any updates to UML, Architecture, Design, or code by module, indicating any other modules that rely on the module updated. We will transition from this method of documentation to a more formal table format as we progress, making certain that the configuration management document serves our needs.

Prior to introducing any changes that will replace existing stubs with executable functions, please save a complete set of source code to our repository as the next minor version (Source Version X.1, X.2, X.3, etc.). Prior to introducing any changes to the executable code as a result of a change to the architecture or design, please save a complete set of source code to our repository as the next major version (Source version 2.0, 3.0, etc.).

Please post the individual files in the repository using the same directory structure as in the IDE, and post the files in a ZIP format as well. 

Repository: https://freepository.com As each class is implemented, please review the supporting written and UML documentation to confirm the interfaces and tests for correctness. 

There are two types of changes, bugs and feature requests/suggestions.

1.Bug Register
- Change RequestID (Bug ID) : 
- Restration Date : 
- Name of Reporter :
- Description of Bug :
- Related Program : 
- Developer :
- Status : unconfirmed, new, resolved, verified, closed 
- Severity : blocker, critical, major, normal, minor, trivial, enhancement 
- Result : fixed, invalid, won’t fix, later, remind, duplicate, works for me 
- Implement in what version : 

2.Feature requests Register
- Change RequestID (FR ID) : 
- Restration Date : 
- Name of Requester : 
- Description of Feature requests/suggestions : 
- Related Program : 
- Developer : 
- Status : unconfirmed, new, resolved, verified, closed 
- Severity : beneficial, essential 
- Result : implemented, accepted 
- Implement in what version : 

Notes to accompany new versions:

A Bug Fix can be implemented without the approval of the Change Control Board (CCB), but each feature request needs to be approved by the CCB. The CCB is comprised of all PIB project members. The CCB will collaborate using MSN Messenger and email. The final change control decisions should be coordinated with Scott, the group’s project manager.

PIB::Bug Reports
Bug 0001 : sample, crash with wrong command.
Registration Date : 14th February, 2006
Short summary :
Status : unconfirmed 

Bug 0000 : sample, crash with wrong command.
Registration Date : 14th February, 2006
Short summary :
Status : unconfirmed 

FR 0000 : sample, add multi page navigate.
Registration Date : 14th February, 2006
Short summary :
Status : unconfirmed 

PIB::Bug 0000
- Change RequestID (Bug ID) : Bug 0000
- Registration Date : 14th February, 2006 
- Name of Reporter : Sena Lee 
- Description of Bug : Command is misspelled. 
- Related Program : AppMain.c 
- Developer : Scott 
- Status : verified 
- Severity : critical 
- Result : fixed

20051130
- Versions 1 and 2 
- wouldn't compile (later learned that the interface forms were not declared correctly in the header files). Not posted to the repository. 

20051203 - Version 3.0 posted 
- simple interface forms (integrated into the Palm OS environment--one additional level of abstraction from standard C or C++ applications. Compiles and executes on the Emulator as well as on a physical device. 

20051204
- Version 3.1 and 3.1.1 posted 
- additional interface forms included. Compiles and executes on the Emulator as well as on a physical device. 

20051205
- Version 3.2 posted 
- Converteed the main PIB application to demonstrate the Transfer+Connect functions. Couldn't get multiple primary pages, so used the NetLib examples to test the connections. Connected, but didn't get a reply (TCP). UDP traffic didn't require a reply. Data was sent as only a string of "char"--will need to engineer a file that resembles a "video signal" for future implementations. 

20051206
- Version 3.2.1 posted 
- Moved the Transfer+Connect functions to a more subordinate location. Lost functionality of the Transfer+Connect within the PIB app, so created a second application (Connect.prc) to demonstrate the lost functionality for later re-integration. Main application more closely aligns with the requirements but additional triggers are still needed. Also, unable to correctly "trigger" from a button, so the Transfer+Connect page (non-functional) is accessible through the "Options" menu for now.
Using freepository with CVS client.

Get cvsroot and paste at ‘CVSROOT’.

1.checkout
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***message

cvs -d sserver;version=1: …

pib checkout pib (in directory D:\PIBv3)

cvs checkout: cwd=D:\PIBv3 ,current=D:\PIBv3

cvs server: Updating pib

cvs server: Updating pib/PIBv32

U pib/PIBv32/AppMain.c

U pib/PIBv32/AppResources.h

U pib/PIBv32/AppResources.xrd

***** CVS exited normally with code 0 *****
2.Login

Admin>Login
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cvs -d :sserver;version=1:senalee2@fr …

pib login 

Logging in to :sserver:senalee2@fre …

***** CVS exited normally with code 0 *****

3.Update/Commit
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4.PalmOS Developer Suite Plugin

Windows>Preference
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It did not support ‘sserver’ protocol.

So I failed.
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